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Notice 
Panavue makes no warranty of any kind with regard to this material, including, but not limited to, the 
implied warranties of merchantability and fitness for a particular purpose. PanaVue shall not be liable for 
errors contained herein or for incidental or consequential damages in connection with the furnishing, or 
use of this material. 
 
This document contains proprietary information that is protected by copyright laws. All rights are reserved. 
No part of this document may be photocopied, reproduced, or translated to any other language without the 
written consent of the PanaVue Company. Owners of PanaVue ImageAssembler licenses are however 
entitled to print one copy of this document for their personal use. Owners of multiple-user licenses may 
reproduce this documentation up to the same quantity as the number of users their license permits. The 
information contained in this document is subject to change without notice. 
 
PanaVue ImageAssembler is a trademark of PanaVue, Inc. 
 
PanaVue Company, June 2000 
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GENERAL INSTRUCTIONS 
 
What is PanaVue ImageAssembler 
 
 
PanaVue ImageAssembler is a professional, high precision, and easy to use software for 
stitching a wide variety of images. 
 
Use it to stitch -or assemble- together panoramic photos, photos of an art object like a painting, 
a tapestry, technical photos for architecture or engineering, aerial or satellite photos, medical 
imagery, microscope slides, photos of houses for real estate sales, multiple part scans of an 
image too large to fit on your scanner like maps, blue prints, posters… 
 
The result can be anywhere between low-resolution images for web publishing to very high 
resolution output for quality paper printing. In the case of 360° panoramic photos, they can be 
saved in a format suitable for viewing with a Virtual Reality viewer. 
 
New with version 2.0, you can select to do the stitch (assemblage) in an all-automatic mode or 
completely manually. You have the choice! 
 
In the manual mode, the interface relies on what users would intuitively do when assembling 
images together: simply click and drag flags to pinpoint some common details lying on the 
overlapping part of consecutive images. This way, throughout all of the stitching process, you 
keep complete control on how images are assembled, and at any step, you can bring a manual 
correction at the "pixel level" since you work on the full images with full zooming capacities. All 
this in a familiar environment with multiple windows. 
 
PanaVue ImageAssembler is also packed with powerful features you can selectively activate to 
customize your working environment. If you want, it will interactively assist you in placing the 
flags, it can use an advanced algorithm to remove color discrepancies between images, warp 
photos, blend them together, wrap a 360 degrees panorama, etc. 
 
PanaVue ImageAssembler is the essential companion to scanners and conventional or digital 
cameras. 
 
 
Related topic: 
 

How to use PanaVue ImageAssembler 
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How to use PanaVue ImageAssembler 
 
 
With PanaVue ImageAssembler you will work with what is called projects. A project includes all 
the information needed to do a stitch, find your lens parameters, or crop the images. When you 
want the software to do a job, you order it to execute a project you have created. Projects can be 
saved for future references. 
 
Depending on which kind of images you want to stitch, follow these simple steps. As you will 
see, instructions are given in terms of projects, to get more information on each type of project, 
just follow the appropriate link. 
 
Case 1: 
To stitch panoramic photos, follow these steps 
 
1- (Optional) If you used a conventional camera (not digital) and had to scan the photos, the 

slides, or the negatives, you may make all photos the same size and at the same time crop 
any excess scan around photos with a Cropping Project. 

 
2- (Optional) If you do not know what type of lens you used, you may have the software finds 

your lens parameters for you. Do it with a Lens Wizard Project. The parameters found there 
can be saved and used in the next step or at any future time. 

 
3- (Mandatory) Stitch and warp the photos with a Photo Stitching Project. 
 
4- (Optional) Crop the stitched image with a Cropping Project. If the image is a 360-degree 

panorama and you want to visualize it with a virtual reality viewer, you should use a 360° 
Wrapping Project instead. In this case, you can save the resulting image as a QuickTime 
VR Panorama. 

 
Instead of just a single row or column, if you need to stitch a whole mosaic of panoramic photos, 
you should first warp and stitch them in rows (or columns) using a Photo Stitching Project. 
Finally, you stitch the rows (or columns) together in an Image Stitching Project, since no warping 
has to be done this time. 
 
Case 2: 
For aerial or satellite photos, scanning of a large image like map, blue print, poster, 
photos of a painting or a tapestry, microscope slides, medical imagery. For any case 
where a relatively flat subject is shot by moving the camera over it to cover the entire 
surface, follow these steps 
 
1- (Optional) Crop any excess scan around photos with a Cropping Project. 
 
2- (Mandatory) Stitch the parts together with an Image Stitching Project. 
 
3- (Optional) Crop the resulting image with a Cropping Project. 
 
tip: When scanning a very large image, it is often easier to stitch it in rows (or columns) after 

which the rows (or columns) are stitched together in another project. But when scanning an 
image of smaller size, it is faster to stitch the mosaic in a single Image Stitching Project. 
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Note that if you place a project and its component images in the same folder, you 
can rename that folder or move the project and images all together to another 
folder. The project will update itself automatically with the new address of its 
images. 
 
Related topics: 
 
 Image Stitching Project 
 Photo Stitching Project 
 360° Wrapping Project 
 Lens Wizard Project 
 Cropping Project 
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Photo Shooting Techniques 
 
 
You can take pictures with a digital or conventional camera, but in the latter case, you have to 
digitize your photos, negatives, or slides. There are some simple techniques however you 
should follow in order to obtain best looking stitched image. 
 
For shooting a panorama (i.e. rotating the camera over a fixed point), follow these 
recommendations: 
 
Ideally, there should be a 20 to 50% overlap between adjacent photos.  
 
You can use an ordinary (rectilinear) lens between 14 and 300mm or a full-frame fisheye lens 
(square photos with 180° diagonal field). The shorter the focal length will be, the less photos you 
will need to shoot. 
 
Contrarily to most other stitching software, PanaVue ImageAssembler lets you stitch photos 
even if the camera was tilted (not held parallel to the ground). Also, you do not need to know 
which type of lens you used since the software can find it for you. 
 
Beware of moving objects, especially moving clouds. Try not to take too much time between 
shootings and do not rely on them for placing flags. 
 
While it is perfectly possible to hand-hold the camera and shoot a panorama, using a tripod and 
ideally a special panhead (a panoramic bracket) to accurately position each exposure will give 
you the best results. A sturdy tripod is recommended. The panhead is most useful for indoor 
shootings where objects are close by and more precision is therefore needed. While you can 
make your own simple bracket to position the optical center of the lenses precisely over the 
rotation axis of the tripod, companies like Kaidan, Peace Rivers, and Bogen offer a wide 
selection to choose from. 
 
Stitch the photos in a Photo Stitching Project optionally followed by a 360° Wrapping Project. 
 
For shooting a subject by moving the camera over it*, follow these recommendations: 
 
Ideally, there should be a 10 to 50% overlap between adjacent photos. 
 
Move the camera along the subject, always keeping the camera perpendicular to the surface of 
your subject (e.g. facing it). 
 
Do not use deforming lenses like fisheyes, but any ordinary (rectilinear) lens will do. 
 
Stitch the photos in an Image Stitching Project. 
 
* : like aerial photos, multiple photos or scans of a painting, a map, a plan or a blue print. 
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Scanning Photos 
 
 
When using a conventional camera, the first thing you will have to do is scan the photos, slides, 
or negatives. Here are some tips to follow when scanning them. 
 
Try not to select an area larger than the image itself, otherwise, there will be an excess margin 
around the scan. If it is the case, remove the margin with a Cropping Project before any attempt 
to warp the photos. 
 
Define the same scanning area for each photo since PanaVue ImageAssembler Photo Stitching 
Project works best with equal-size photos. This restriction does not apply to Image Stitching 
Project. 
 
Finally, try to make the center of your scans coincide with the center of the photos. For optical 
reasons, warping will not be as effective if the centers do not match. 
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Scanning a Large Image in Parts 
 
 
When scanning a large image in smaller scans, there are some simple tricks to follow to ensure 
a good quality stitch. 

 
Try to get about 2 to 12 cm (1 to 5 inches) overlap between adjacent scans. 
 
Depending on the type of scanner used, try not to select in your scans the extreme 1 cm 
(0.5 inch) on the border of the scanner glass. This is preferable because the scanner frame 
usually raises above from the glass and this creates a small "air gap" between the image 
and the glass along a narrow band as is illustrated below. 

 
Along the band where this gap lies, the digitized image will appear darker than it really is 
and this might show up in the final stitched image. 
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Image Stitching Project 
 
 
An Image Stitching project is used for aerial or satellite photos, scanning of a large image like a 
map, a blue print, a poster, photos of a painting or a tapestry, microscope slides, medical 
imagery, or any case where a relatively flat subject is shot by moving the camera over it to cover 
the whole surface. 
 
When a new Image Stitching Project is created it does not contain any source image. You have 
to add images to the project and assign numbers to them. The numbers tell PanaVue 
ImageAssembler where to place the images. Here is what you should do for the three situations 
likely to occur: 
 

Stitching a row of images.  
You should assign number 1, 2, 3, 4, etc, to consecutive images starting from the left. 

 
Stitching a column of images.  

You should assign number 1, 101, 201, 301, etc, to consecutive images starting from 
the top. 

 
Stitching a mosaic of images.  

In this case, you can use two different methods. See the online-help tutorials  for an 
example of each method. In general Method 2 is faster, but Method 1 is easier, 
especially when dealing with more than 4 or 6 images and the input method (scanning 
or photo shooting) cannot insure an equal overlapping between images. 
Method 1- In a first step, you stitch the images by rows (or by columns). You create 
one project for each row (or column) and save the resulting images. In a second step, 
you stitch all the rows (or columns) together to produce the final image. Note that at this 
step you must set on the option "Source images are stitched images from a previous 
ImageAssembler Project".  
Method 2- You can directly stitch every image in a single project. For an illustration on 
how to number the images in this method, see the last diagram at the bottom of this 
page. 

 
Tip: when adding images to a project, you can select and open multiple files in one time by 
using the CTRL (control) or SHIFT key. 
 
Ounce you have opened and numbered the images to stitch, you select the options you want in 
the "Options" tab of the Project Manager. If you do not know how to set the options, you can 
proceed with their default values. At anytime, the "Reset" button will reset the buttons to their 
default values. 
 
About flags 
 
If you select the option "Automatic stitch", then you do not have to use the flags, they are 
disabled (gray-colored). When executing the project the ImageAssembler will automatically find 
the relative position of the images and will also place the flags for you. 
 
If instead you select the option "Manual stitch with flags" then you have to click and drag the 
flags with your mouse. You place the flags on some common details lying on the overlapping 
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part of consecutive images. When you execute the project, PanaVue ImageAssembler will stitch 
the images by placing corresponding flags with the same number one on top of the other. 
 

Tip: clicking on this toolbar button  lets the ImageAssembler assist you in positioning the 
flags. 
 
The next three diagrams show you how PanaVue ImageAssembler uses flags to stitch the 
images (to keep diagrams small, only a limited number of images are represented). 
 
For a row of images: 

 
 
For a column of images:  
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For a mosaic of images: 

 
 
 
Related topics: 
 
 Options (Image Stitching Project) 
 Scanning a Large Image in Parts 
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Photo Stitching Project 
 
 
A Photo Stitching project is used to stitch photos of a panorama. The difference between an 
Image Stitching Project and a Photo Stitching Project lies in the warping. In a Photo Stitching 
Project, a special type of warping is applied on the photos immediately before they are stitched 
together. This special warping is equivalent to projecting the individual images over a sphere or 
a cylinder. PanaVue ImageAssembler takes care of all the technical details so you might not 
even realize it is doing this kind of projection except when you will look at the resulting image. 
 
When a new Photo Stitching Project is created it does not contain any source image. You have 
to add photos to the project and assign numbers to them. The numbers tell the ImageAssembler 
where to place the photos. Here is what you should do for the three situations likely to occur: 
 

Stitching a row of photos.  
You should assign number 1, 2, 3, 4, etc, to consecutive photos starting from the left. 
 

Stitching a column of photos.  
You should assign number 1, 2, 3, 4, etc, to consecutive photos starting from the top. 
 

Stitching a mosaic of photos.  
You should first stitch photos by rows with a Photo Stitching Project, then stitch the 
resulting images in a column with an Image Stitching Project. 

 
Tip: when adding images to a project, you can select and open multiple files in one time by 
using the CTRL (control) or SHIFT key. 
 
About flags 
 
If you select the option "Automatic stitch", then you do not have to use the flags, they are 
disabled (gray-colored). When executing the project the ImageAssembler will automatically find 
the relative position of the images and will also place the flags for you. 
 
If instead you select the option "Manual stitch with 2 flags" then you have to click and drag the 
flags with your mouse. There are two flags between each pair of images. You place the flags on 
some common details lying on the overlapping part of consecutive images. When you execute 
the project, PanaVue ImageAssembler will stitch the images by placing corresponding flags with 
the same number one on top of the other. 
 
The option "Manual Stitch with 1 flag" allows you to use only one flag between each pair of 
images. 
 
Using only one flag instead of two has many advantages. It is faster, it forces the images to 
follow a straight line (no rotation allowed), and it keeps all images at their original size. With two 
flags, images can be rotated and scaled in the stitching process, so you should use the two flag 
option only for particular situations. 
 

Tip: clicking on this toolbar button  lets the ImageAssembler assist you in positioning the 
flags. 
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Related topics: 
 
 Options (Photo Stitching Project) 
 Lens Selection 
 Photo Shooting Techniques 
 Scanning Photos 
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360° Wrapping Project 
 
 
A 360° Wrapping project is the last project you will use to finalize a 360° panorama. This project 
uses the resulting stitched image from a Photo Stitching Project and crops the image as well as 
aligns, color adjusts, and blends the left and right ends. The output image from this project is 
ready to be saved in a format compatible with one of the VR Viewers available on the market 
(like Apple QuickTime). When the panorama will be displayed in the VR Viewer, the joint 
between the two extremities will be seamless and invisible thanks to the process done in the 
360° Wrapping Project. PanaVue ImageAssembler lets you save a panorama in Apple 
QuickTime VR format, see Making QuickTime VR Panoramas for more information. 
 
Tip: It is important not to crop the 360° panorama prior to bringing it into the 360° Wrapping 

Project. This Project needs the whole image including the overlapping part of the two 
extremities to do an efficient color adjustment and image blending. 

 
If you use this kind of project to crop an ordinary image (that is not 360 degrees), set to 0% the 
image blending option and clear the color adjustment box of the Options tab of the Project 
Manager 
 
About flags 
 
Using your mouse, click and drag the two flags to an appropriate position. The two flags should 
be placed over the same image detail lying on the overlapping parts of two extremities of the 
panorama. One flag is placed on the left end the other on the right end. The rectangular lines on 
the panorama represent the area that will be cropped. You can click and drag the top and 
bottom lines to resize the cropping area. 
 

Tip: clicking on this toolbar button  lets PanaVue ImageAssembler assist you in positioning 
the flags. 
 
Related topics: 
 
 Options (360° Wrapping Project) 
 Making QuickTime VR Panoramas 
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Making QuickTime VR Panoramas 
 
 
PanaVue ImageAssembler lets you save panoramas in QuickTime VR format from Apple 
Computer, Inc. To make a QuickTime VR Panorama do the following: 
 
1- (Optional) Crop any excess scan around photos with a Cropping Project 
 
2- Warp and Stitch the photos with a Photo Stitching Project 
 
3- Finalize the Panorama with a 360° Wrapping Project and save the resulting image from this 

project. In the Save As dialog box, select the "QuickTime VR Panorama (*.mov)" type. 
 
To create QuickTime VR Panoramas, you need to have QuickTime 3 (or higher) installed on 
your system. You must install QuickTime with authoring capabilities, to do that, choose the "Full" 
installation type or "Custom" type and select "authoring capability". 
 
To visualize the panorama, use the MoviePlayer application that comes with QuickTime 3 or the 
QuickTime Player application that comes with QuickTime 4. You can also use a web browser 
(Netscape or Microsoft Explorer) with the QuickTime plugin properly installed. This plugin should 
install itself automatically at the same time you install QuickTime provided you have one of the 
web browsers on your machine at the time of the installation. 
 
You can get QuickTime from the Apple website at www.apple.com 
 
Here are some other reasons why you could not create a QuickTime: 

- Not enough free space on the hard disk where is located your "TEMP" folder. 
- The size ratio of the image is incorrect; image must be more wide than high (for example 
the width must be at least two times the height). 
- Too large image size. PanaVue ImageAssembler has the capacity to create images much 
bigger than what can handle QuickTime. You should try first to create QuickTimes from 
relatively small images, like images that are less than 1 MB when uncompressed. 
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Lens Wizard Project 
 
 
A Lens Wizard project will determine the focal length, the distortion, and the type (ordinary of 
fisheye) of your lens. It will also find the tilt angle of your camera for a particular group of photos. 
All these parameters are found in a single step. 
 
When a new Lens Wizard Project is created it does not contain any source image. You need to 
add only two or three consecutive photos into a Lens Wizard Project in order to compute the 
lens parameters. If possible, it is better to use three photos. Once these parameters are 
computed, you can save them and later use them to stitch as many photos as wanted with a 
Photo Stitching Project. 
 
Note: If the focal length found is very long (150, 200, or 300mm) and it does not represent your 
lens at all, this is not necessarily an error. It indicates that there is no need to project the photos 
inside a sphere in order to stitch them. This is normal if the photos are not part of a panorama. 
For example, this is normal for photos to stitch with an Image Stitching Project (aerial or satellite 
photos, photos of a painting or a tapestry, microscope slides, medical imagery, any case where 
the subject is shot by moving the camera over it to cover the whole area). In this case, you can 
still compute a distortion value with a Lens Wizard Project and use it to stitch photos with an 
Image Stitching Project. 
 
When you add photos to a Lens Wizard Project, PanaVue ImageAssembler will ask for a 
number. This number tells the software where to place the photo. 
 

For finding parameters for a row of photos.  
You should assign number 1, 2, and 3  to consecutive photos starting from the left. 
 

For finding parameters for a column of photos.  
You should assign number 1, 2, and 3 to consecutive photos starting from the top. 

 
Tip: when adding images to a project, you can select and open multiple files in one time by 
using the CTRL (control) or SHIFT key. 
 
About flags 
 
In a Lens Wizard Project you must take your mouse and place every flag to an appropriate 
position. If your project contains two images, there will be seven flags on each image. If your 
project contains three images, then images number 1 and 3 have four flags each, while image 
number 2 has eight flags (four to stitch it with image 1 and four other to stitch it with image 3) 
 
You place the flags on some common details lying on the overlapping part of consecutive 
images. When you execute the project, PanaVue ImageAssembler will use these flags to 
compute all the parameters and stitch the images. 
 

Tip: clicking on this toolbar button  lets the ImageAssembler assist you in positioning the 
flags. 
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Important note: In a Lens Wizard Project, to find accurate parameter values, try to spread the 
flags over the overlapping regions, do not cluster them. It helps the software a lot to place some 
flags closed to the corners whenever it is possible. Look at flags 1, 3, and 4 between image #2 
and #3 in the following image. 
 
Here is an example on how to place the flags: 
 

 
 
Related topic: 
 
 Options (Lens Wizard Project) 
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Cropping Project 
 
 
A Cropping project is used to extract part of (to crop) one or many images. It is useful in 
removing any excess scan around source images or finalizing a stitched image. 
 
The PanaVue ImageAssembler cropping tool is somehow different but more powerful than what 
is usually found in image-editing software. 
 
Following the usual ImageAssembler interface, you click and drag flags with your mouse. 
 
Cropping rules: 

1) The round flag represents the upper left corner and the triangular flag the lower right 
corner of the cropped image. 
 
2) The line going through the round and the square flag always corresponds to the top of 
the cropped image. 

 
According to these simple rules, not only can you crop images, but you can flip and rotate them 
with arbitrarily angle in the same step. 
 
By default, cropped and source images are saved in the same folder, but cropped images have 
the "cropped" suffix appended to their filename. 
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PRINTING 
 
Use the Print Command in the File Menu to print the active image. This command presents a 
Print dialog box, where you may specify the number of copies, the destination printer, and other 
printer setup options. 
 
PanaVue Image Assembler will print the exact portion of the image as it appears in the image 
window. To print a different part of an image, use the Zoom In, the Zoom Out, the Fit buttons, 
and the slide bars. You can easily select which part of the image you want to print. To print the 
whole image, zoom out until the entire image is displayed. 
 
The Print Preview Command of the File Menu lets you visualize on your monitor the way the 
image will be printed. It is a fast an easy way to try different print settings and get acquainted 
with PanaVue ImageAssembler printing facilities. 
 
The output can be split over many pages. You can control over how many pages the output is 
printed with the Print Size dialog box. This box will follow the Print dialog box after you clicked 
the Print Command or Print Preview Command in the File Menu. 
 
The Print Size dialog box sets the size of the printing area. Printing can be split over many 
pages if the "print size" is set to be larger than the "paper page size".  
 
However, the image can only be printed over a single row or a single column of pages. One of 
the intended uses of this dialog box is to allow printing of a panorama as a “banner”, e.g. spread 
the panorama over a single row of many pages. 
 
By setting the right printing area ("print size") in this dialog box, and by selecting the right choice 
of paper for your printer with the Print Setup command of the File menu, you can: 
 

Print an image as a “banner”, e.g. on a continuous piece of paper consisting of many pages 
(this option might not be supported by your printer). 
 
Print an image on special oversized paper or paper roll. In this case you print on a single 
page, but this page can be very long (this option might not be supported by your printer). 
 
Print the image on many separate pages. After you have printed your image, you can 
manually place all the pages side by side to rebuilt the complete image. This is supported by 
all printers. 

 
Here are explained some terms used in the Print Size dialog box. 
 
Printer Resolution 

Horizontal: The horizontal resolution of your printer in dots per inch (dpi) 
Vertical: The vertical resolution of your printer in dots per inch (dpi) 
Some printers support different resolutions, in this case you can change this value with the 
Print Setup command of the File menu 
 
 

Part of Image to Print 
The part of the image (in pixels) to be printed. PanaVue ImageAssembler prints the exact 
portion of the image as it appears in the image window on your screen, this way you can 
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easily select which part of the image you want to print. For example, to print the whole 
image, zoom out until the entire image is displayed. 
 

Printer Page Size 
The size of the paper in cm, inches, or dots, as it is actually set for your printer. You can 
change this value with the Print Setup command of the File menu. 
 

Print Size 
This is where you set the size of the printing area. Enter this size either by width, height, 
resolution, or the number of pages over which to spread the printing. 
 
Resolution: The resolution here is not the same thing as the printer resolution. Printer 
resolution is expressed in dpi (dots per inch) and is the physical capability of your printer. 
The resolution here is the “image resolution”, it is simply found by dividing the width of the 
part of the image you want to print (expressed in pixels) by the width of the printing area 
(expressed in inches). 
 
If image resolution is less than printer resolution, this means that you under use your printer 
capabilities; some degree of pixelation artifact can even appear if image resolution is very 
low. By printing image containing enough pixels so that the image resolution is greater than 
or equal to your printer resolution, you ensure that all of your printer resolution capability is 
used. 
 
Extent: Depending on the aspect ratio of your image, there is a maximum number of pages 
over which you can print an image. Take the example where the image is much wider than 
high (a panorama), if you split the printing over too many pages, then the height of a single 
paper page will not be enough to hold the entire height of your image. In this case, the 
maximum number of pages in the row is reached when the height of the printed image 
equals the height of a page. 
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COMMAND LINE 
 
Calling PanaVue ImageAssembler from the Command Line 
 
You can automate the stitching process by calling PanaVue ImageAssembler from almost any 
other application. An application can call the ImageAssembler repeatedly to assemble a large 
number of groups of images in batch, or can use the ImageAssembler to do the stitching job 
while showing its own interface to the user. 
 
This kind of automation is realized by calling PanaVue ImageAssembler from the "command 
line", it is quite powerful because you can call the ImageAssembler and use it with any existing 
project, substituting the original project images with new ones. Prior to calling it from the 
command line, you must create projects as usual, by using ImageAssembler with its normal 
windows interface. 
 
You can order PanaVue ImageAssembler to execute by typing the command in a Dos window 
(command prompt) but more interestingly, the ImageAssembler can be launched from any other 
application written in a language that supports shell execution commands (Visual Basic, C++, 
Delphi…). 
 
The Command Line feature is not included as a standard function in the release version 
of PanaVue ImageAssembler, it is an add-on feature sold separately, it is activated in the 
trial version for demonstration and testing purposes. If you are interested in this feature, see our 
website for information on the price and how to add it to your PanaVue ImageAssembler 
software. 
 
To call PanaVue ImageAssembler from the command line, use the following syntax: 
 
<path>\Panima.exe <project filename> <resulting image filename> /f:<image format> /b:<bits 
per pixel> /c:<compression> /v 
 
where: 
<path> is the complete path where PanaVue ImageAssembler software is installed 
<project filename> is the complete path and filename of the project (*.vst) file you intend to use 
<resulting image filename> is the complete path and filename of the resulting image you intend 
to create 
<image format> can be any of bmp, os2, jpg, tif, tga, pcx, psd, ras, pct, png. 
<bits per image> can be 0, 1, 4, 8, or 24, not every bit depth is supported by any file format. 0 
here stands for 256 grayscale, while 8 stands for 256 colors. 
<compression> is a JPEG compression value between 2 to 256, 2 being the least compressed. 

/v is for verbose, when this switch is on, PanaVue ImageAssembler will display error 
message in a pop up window. This is mainly useful for debugging. 

 
The following table summarizes which bit dept and compression is supported by a file format. 
 
/f: /b: /c: File Format 
bmp 0, 1, 4, 8, 24 N/A Windows BMP 
os2 0, 1, 4, 8, 24 N/A OS/2 BMP version 1.x 
jpg 0, 24 2 to 256 JPEG 
tif 0, 1, 4, 8, 24 N/A TIFF 
tif 0, 24 2 to 256 TIFF with JPEG compression 
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tga 0, 24 N/A TARGA 
pcx 0, 1, 4, 8, 24 N/A Zsoft PCX 
psd 0, 1, 8, 24 N/A Adobe PhotoShop 3.0 
ras 0, 1, 4, 8, 24 N/A Sun Raster 
pct 0, 1, 4, 8, 24 N/A MacPict 
png 0, 1, 4, 8, 24 N/A Portable Network Graphic 
 
Example: 
 
C:\Program Files\PanaVue\PanaVue ImageAssembler\Panima.exe 
C:\MyProjectFolder\Project01.vst C:\MyResultFolder\ResultImage0001.png /f:png /b:24 
 
This example will launch PanaVue ImageAssembler without its user-interface; the 
ImageAssembler will use project Project01.vst (with its option settings and with the images it 
refers to) to produce the stitched image ResultImage0001.png. This resulting image will be in 
24-bit color, in png format. 
 
Notes: 
 
The /f, /b, and /c switches refer to the resulting (stitched) image. Note that both project and 
resulting image filenames are mandatory while the switches are optional, default switch values 
are /f:bmp /b:24.  
 
The parameters must be separated by a single space, while no spaces are allowed within the 
path and filename of the two first parameters (project and resulting image filenames and 
paths). 
 
You can replace the individual image files that a project refers to by other images. To do this, 
you do not have to modify the project itself, just substitute the image files with new ones with 
same names. With this technique, it is possible to use the same project to stitch many different 
sets of images. 
 
Here is a simple example on how to call PanaVue ImageAssembler in Visual C++. A more 
complete code would involve calling the ImageAssembler in a separate thread while showing 
some kind of animated waiting image in the user interface of the main thread to show it is doing 
a stitch. 
 
void CCommandLineCall::Run()  
{ 
 SHELLEXECUTEINFO *pExecInfo; 
 DWORD dwExitCode; 
 INT iExitCode; 
 
 
 // fill structure pExecInfo 
 pExecInfo = new SHELLEXECUTEINFO; 
 pExecInfo->cbSize = sizeof(SHELLEXECUTEINFO); 
 pExecInfo->fMask = SEE_MASK_NOCLOSEPROCESS; 
 pExecInfo->hwnd = NULL; 
 pExecInfo->lpVerb = "open"; 
 pExecInfo->lpFile = "C:\\Program Files\\PanaVue\\ 



 23

PanaVue ImageAssembler\\Panima.exe"; 
 pExecInfo->lpParameters = "C:\\MyProjectFolder\\Project01.vst  

C:\\MyResultFolder\\ResultImage0001.png /f:png /b:24"; 
 pExecInfo->lpDirectory = NULL; 
 pExecInfo->nShow = SW_SHOW; 
 
 if (!ShellExecuteEx(pExecInfo)) 
 { 
  AfxMessageBox("Cannot execute"); 
  return; 
 } 
 
 dwExitCode = STILL_ACTIVE; 
 while (dwExitCode == STILL_ACTIVE) 
 { 
  GetExitCodeProcess(pExecInfo->hProcess, &dwExitCode); 
  Sleep(1000); // to reduce processor time load for this thread 
 } 
 
 if (dwExitCode != 0) 
 { 
  iExitCode = (INT)dwExitCode; 
  // Write error recovering code here 
 } 
 else 
  AfxMessageBox("Ended with success", MB_ICONINFORMATION); 
 
 delete pExecInfo; 
} 
 
To get a description of possible values of iExitCode in the previous example, see the complete 
return value table with explanations. 
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Returned Value Table 
 
Here is the list of all possible values returned by PanaVue ImageAssembler when called from 
the command line along with some explanations. 
 
0  : Success 
 
Error values: 
 
Negative: 
-1  : Not enough memory 
-2  : Invalid bitmap handle 
-3  : Not enough memory 
-4  : Error seeking to position 
-5  : Error writing file 
-6  : File not present - abort 
-7  : Error reading file 
-8  : Invalid filename specified 
-9  : Invalid file format 
-10  : File not found 
-11  : Invalid width/height 
-12  : Image format recognized, but sub-type not supported 
-13  : Invalid parameter passed 
-14  : Not able to open file 
-15  : Unknown compression format 
-16  : Requested file format not available 
-17  : VGA card only supports 256 colors (8 bit) 
-18  : Printer error 
-19  : Data CRC check error 
-21  : Invalid QFactor specified 
-22  : TARGA not installed 
-23  : Invalid compression format 
-24  : X origin specified invalid 
-25  : Y origin specified invalid 
-27  : Invalid bits/pixel 
 
Positive: 
3  : The execution will not start due to an invalid source image numbering, please check this item 
with the Project Manager Window. 
4  : To execute, you must supply a suffix in order to form the resulting image filenames. See the 
option tab of the Project Manager Window 
5  : Unable to open file, it may be the result of insufficient memory space on hard disk or an 
unrecognized image format. 
6  : Unable to open one of the images, this may be the result of insufficient available memory. 
7  : Cannot find Ph_math.dll Reinstall ImageAssembler or contact PanaVue to get this file. 
8  : The actual version of ImageAssembler does not support this project file format anymore 
9  : Cannot copy the image on the clipboard, it is probably due to insufficient memory space, or 
an image format not supported by ImageAssembler. 
10  :Cannot copy the image on the clipboard, maybe the clipboard is locked by another 
application, try again later. 
11  : The execution will not start due to an invalid number of source images. 
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12  : The execution will not start. A project cannot contain a mix of color and grayscale source 
images (except for Cropping Project). 
13  : ImageAssembler is unable to adjust colors. 
20  : Memory allocation failure!  Resources are low, please close some applications and try 
again. 
21  : Not enough disk space available. Please free some space and try again. 
22  : Not enough memory space available to perform the operation. Please close some 
applications and/or free some space on your hard disk and try again. 
26  : PanaVue ImageAssembler has encountered a problem while opening the project file: the 
specified file format is not supported 
27  : PanaVue ImageAssembler cannot automatically place the image(s). You can however do a 
manual stitch with flags and rerun the project. 
29  : Windows system error; 
30  : Unable to find the lens setting for these photos. Verify that you have not placed flags on 
points situated above 90 degree or below -90 degrees from horizon line. Also note that fisheye 
lenses with more than 180 degrees field of view are not supported. 
31  : Unable to do lens fine tuning for this project. The project must contain a number 1 and 
number 2 image in order to realize a lens fine tuning. Also note that too small images cannot be 
automatically stitched. 
33  : Undetermined error 
100  : Failure from unknown causes 



 26

Command Line Sample Source Code 
 
To see a short example on how to call PanaVue ImageAssembler from another application using 
the command line, see Calling PanaVue ImageAssembler from the Command Line. 
 
We have also included a complete C++ sample source code showing how to call PanaVue 
ImageAssembler from the "command line". This sample code is only included in the trial version 
of the software or with the command line add-on. You will find this code in folder: "…\Command 
Line Sample Source Code" under the folder where you have installed PanaVue 
ImageAssembler (by default it should be "C:\Program Files\PanaVue\PanaVue 
ImageAssembler\Command Line Sample Source Code"). 
 
You can build the application yourself if you have Visual C++ 6. Otherwise you can look at the 
very simple code found in the CCommandLineCallDlg::OnButtonRun() function of 
CommandLineCallDlg.cpp file. You can also try the compiled application CommandLineCall.exe. 
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GLOSSARY 
 
Column: A vertical, top down sequence of overlapping photos or scans.  
 
Distortion: A lens without any distortion is one that always represents a straight line subject as 

a straight line on the photo (without any curvature). Unfortunately, it is not always the 
case. Lens distortion can be convex (also called "barrel") or concave ("pin cushion"). 
Zoom lens with their variable focal length will distort the image in the following way: 
convex distortion for short focal lengths, concave for long ones. For example a 28 to 
80mm zoom will induce a convex distortion at 28mm and a concave distortion at 80mm. 
Somewhere in the middle, the lens is relatively "perfect".  
 
Good quality fixed focal length lenses tend to be non-distorted.  

 
Flag: A visual object used to pinpoint an image. By placing flags on images, you indicate to the 

ImageAssembler how you want the images to be stitched, or cropped. The crossing of the 
two lines shows the exact location of a flag. 

 
 

 
Focal Length: The focal length of a lens is the distance between the optical center of your lens 

and the exposed surface (the film of a conventional camera or the sensors of a digital 
camera). It is usually expressed in millimeters (mm). The longer the focal length is, the 
closer the subject appears and the narrower the field of view is. The opposite is also true. 
Zoom lenses have variable focal length (for example 28 to 80mm) while fixed lenses have 
a unique focal length (for example a 24mm lens). 

 
Mosaic: A matrix (rows and columns) of contiguous images stitched into a single image. In an 

Image Stitching Project, PanaVue ImageAssembler lets you directly stitch a mosaic of 
small parts of a large image (like a blue print or a map), but to stitch a mosaic of panoramic 
photos, you need to warp and stitch them in rows (or columns) with a Photo Stitching 
Project, and finally stitch the rows (or columns) with an Image Stitching Project. 

 
Panorama: Photos that cover a wide field of view, which can extend as much as 360° around. 

Panoramas are taken by standing over a fixed point and rotating the camera (usually from 
the left to the right but it can be from top to bottom). The use of a tripod is recommended. 
Panoramas can be taken indoors or outdoors.  

 
Project: A "project" includes reference to all the individual photos or images you want to 

process together with the option setting you selected, the relative position of the images, 
the camera lens type, etc… In other words, a project includes all the information the 
ImageAssembler needs to effectively perform a job. 
 
PanaVue ImageAssembler is divided into 5 different types of projects. Each type of project 
does a particular kind of job: Image Stitching, Photo Stitching, 360° wrapping, Lens Wizard 
and Cropping. When you start a new project, you select its type depending on what you 
want to do with the images. Projects can be saved for future references. 
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Note that if you place a project and its component images in the same folder, you can 
rename that folder or move the project and images all together to another folder. The 
project will update itself automatically with the new address of its images. 

 
Row: A horizontal, left to right sequence of overlapping photos or scans. 
 
Stitching: The process of seamlessly assembling images, where many source images are 

assembled into a single resulting image. 
 
 
Tilt: The tilt is the vertical angle of the camera (when shooting an horizontal row of photos). A tilt 

of 0 degree means the camera is pointing toward the horizon (it is held parallel to the 
ground), with a tilt of 90 degrees, the camera is pointing directly upward toward the sky, 
and with a tilt of -90 degrees, the camera is facing the ground. 

 
VR Viewer: A Virtual Reality Viewer is a special software that displays 360° panoramas in such 

a way that users can navigate in the image. Panoramas have to be saved in the 
appropriate format. Many companies make VR Viewers and each one has its own specific 
file format. PanaVue ImageAssembler lets you save panoramas in QuickTime VR file 
format from Apple Computer Inc. 

 
 
Warping: The process of bending and stretching photos in order to stitch them seamlessly. For 

panoramic photos in a Photo Stitching Project, warping is equivalent to projecting the 
images inside a sphere or a cylinder. The wider your lens' field of view is, the more 
important warping becomes. In an Image Stitching Project, images are warped only if a 
lens distortion value different than 0 is selected. 
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TO CONTACT PANAVUE 

 
 
To get support: 
 

First, you should check our Help Desk at PanaVue’s web site www.panavue.com. It gives 
answers to the most frequently asked questions (FAQ) and also contains tricks and tips 
about the ImageAssembler. If you do not find a satisfactory answer there, try the following: 
Email: support@panavue.com with detailed information concerning the problem 
Fax: 1-418-688-4723 

 
To contact PanaVue: 
 

Internet: www.panavue.com 
Fax: 1-418-688-4723 
Mail: PanaVue 

  616 boul. Rene-Levesque Ouest 
  Quebec (Qc) 
  Canada G1S 1S8 
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